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• Premisa del estudio: La metodología de campo y los protocolos de análisis de imágenes utilizando la tomografía 

acústica fueron desarrollados y evaluados como una herramienta para calcular la cantidad de descomposición 
interna y daño de los árboles vivos, con especial atención a los árboles de selva tropical con formas de tronco 
irregulares. 

• Métodos y Resultados: Se exploraron troncos vivos de una diversidad de especies arbóreas en selvas tropicales de 
la República de Panamá utilizando un Tomógrafo Sónico Argus Electronic PiCUS 3 y se evaluó la cantidad y los 
patrones de descomposición interna. Se empleó un protocolo utilizando el software de análisis ImageJ para 
cuantificar las proporciones de madera intacta y comprometida. Los protocolos proporcionan estimaciones 
replicables de descomposición interna y cavidades para árboles de diferentes formas, densidad de madera y grosor 
de corteza. 

• Conclusiones: La tomografía sonora, junto con el análisis de imágenes, proporciona un enfoque eficiente y no 
invasivo para evaluar los patrones de descomposición y la integridad estructural incluso de árboles de forma 
irregular. 

 
Palabras claves: tomografía acústica; Tomógrafo Sónico Argus PiCUS 3; ImageJ; Árboles tropicales.  

 
La descomposición interna es una fuente importante de 
mortalidad para los árboles maduros ya que los árboles 
estructuralmente debilitados por la pudrición del 
corazón (núcleo) y la putrefacción de los contrafuertes 
son más susceptibles a romperse y caer por fuertes 
vientos o precipitaciones (Putz et al., 1983, Worrall y  
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Harrington, 1988; Shaw et al., 2004). Dicha 
descomposición interna es difícil de detectar, sin 
embargo, amenaza la propiedad y las personas en los 
bosques urbanos (Terho y Hallaksela, 2008), provoca 
la pérdida de madera en la industria forestal (Donnelly 
y Davison, 2008) y la fracción de biomasa y la reserva 
mundial de carbono almacenado no han sido bien 
entendidas (Heineman et al., 2015). Silvicultores, 
arboristas, fisiólogos, patólogos de plantas y 
ecologistas han buscado desde hace tiempo métodos 
confiables, portátiles, no invasivos para detectar, medir 
y visualizar la descomposición interna en árboles vivos 
(Johnstone et al., 2010).  
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La pudrición del corazón a menudo es determinada de 
forma forense después de talar los árboles (Heineman 
et al., 2015), pero la comprensión de la dinámica y el 
impacto de la descomposición de la madera en el 
crecimiento y la supervivencia de los árboles requiere 
medidas mínimamente invasivas que no dañen los 
árboles. Se han utilizado taladros de avance constante 
para detectar la descomposición interna midiendo la 
resistencia a la perforación a medida que la broca pasa 
a través de maderas de diferente densidad (Seaby, 
1991, Bethge et al., 1996; Costello y Quarles, 1999; 
Johnstone et al., 2007, 2010). Aunque estas mediciones 
son útiles para medir la variación en la densidad de la 
madera, las mismas se ven afectadas por la humedad y 
el arrastre de la madera (Seaby, 1991), y la perforación 
imparte un pequeño riesgo de infección y decoloración 
de la madera. (Kersten y Schwarze, 2005, Helliwell, 
2007, Johnstone et al., 2010); sin embargo, la 
perforación no suele conducir a descomposición a 
largo plazo (Weber y Mattheck, 2006). Se han 
analizado abordajes menos invasivos, incluyendo 
resistencia a la corriente pulsada (Thornton, 1979), 
exploraciones radiográficas de tomografía 
computarizada (Seifert et al., 2010), ondas de estrés 
(Lawday y Hodges, 2000), resonancia magnética 
nuclear (Pearce et al., 1994) y ultrasonido (Tainter et 
al., 1999, Martinis Et al., 2004), pero ninguno produce 
de manera fiable una representación interpretable de la 
descomposición de la madera mientras ser prácticos 
para usar en el campo (Johnstone et al., 2010). 

Argus Electronic GmbH (Rostock, Alemania) ha 
desarrollado el Tomógrafo Sónico PiCUS 3 para la 
detección no invasiva de la descomposición interna y 
cavidades en los árboles vivos.  Funciona midiendo la 
variación en la velocidad del sonido a través del tronco 
para determinar patrones de integridad de la madera. 
La tomografía PiCUS ha demostrado ser eficaz para 
detectar y visualizar patrones de descomposición y 
otros daños en árboles vivos, generalmente dentro de 
5% de las estimaciones visuales de secciones 
transversales (Gilbert y Smiley, 2004) (vea Deflorio et 
al., 2008, para conocer las limitaciones con 
desintegración incipiente). El manual detallado del 
tomógrafo sónico PiCUS (Versión Q72) proporciona 
protocolos que funcionan adecuadamente para 
aplicaciones arboriculturales y en árboles con 
estructura simple (circular a oval en la sección 
transversal) de las zonas templadas del norte (Gilbert 
Y Smiley, 2004). Sin embargo, nuestra experiencia en 
investigación ecológica utilizando el PiCUS 3 para 
medir la descomposición interna en muchas decenas de 

especies de árboles de selva tropical ha revelado 
importantes limitaciones en la guía proporcionada en 
el manual sobre cómo tratar árboles que tienen sistemas 
de raíces grandes, contrafuertes o son de otra manera 
de forma irregular (por ejemplo, la página 14 del 
manual de PiCUS).  

La afinidad de las formas irregulares de los árboles 
en los bosques tropicales, incluyendo los bosques 
urbanos (Smith, 1972), y un creciente interés por la 
descomposición de la madera de los árboles tropicales, 
sugiere la necesidad de desarrollar y evaluar un 
protocolo estandarizado para su aplicación a una 
amplia diversidad de tipos de árboles. Como tal, para 
facilitar el uso del PiCUS 3 y evaluar cuantitativamente 
la descomposición interna de los árboles utilizando 
técnicas mínimamente invasivas en la investigación 
ecológica, presentamos un detallado protocolo de 
utilización del PiCUS, con especial referencia a los 
árboles de bosque tropical con formas irregulares. 
Aunque no hemos puesto a prueba este abordaje con 
otros tomógrafos tales como el ARBOTOM 
(www.rinntech.de), la tecnología subyacente similar 
sugiere que nuestro abordaje general debe ser útil para 
otros tomógrafos sónicos. Comparamos patrones de 
descomposición producidos utilizando diferentes 
formas de instalación de los sensores sónicos, y 
hacemos varias sugerencias para el uso óptimo en 
árboles con formas irregulares. Finalmente, incluimos 
un protocolo de análisis de imágenes para cuantificar 
la descomposición interna sobre la base de la 
producción del PiCUS 3. 
 

MÉTODOS Y RESULTADOS 
 

El Tomógrafo Sónico PiCUS 3 (Argus Electronic 
GmbH) mide la velocidad aparente del sonido a lo 
largo de numerosas cuerdas de la sección transversal 
del tronco de un árbol y luego identifica áreas del 
tronco donde el sonido tarda más tiempo de lo esperado 
en recorrer esa distancia a través de la madera sólida, 
ya que el sonido viaja más lentamente a través de la 
madera descompuesta y cavidades que a través de 
madera sólida. Los tiempos de recorrido para cada 
cuerda son comparados con la velocidad (más rápida) 
a través de la madera sólida dentro del mismo tronco, 
en lugar de compararlos con un estándar externo. Esto 
facilita el uso del PiCUS 3 a través de diversas especies 
de árboles creciendo bajo diferentes condiciones. El 
programa de computadora patentado incluido en el 
PiCUS 3 analiza los datos de tiempo de tránsito 
acústico y proporciona imágenes de los patrones de 



Applications in Plant Sciences 2016 4(12): 1600060  Translation of Gilbert et al.— Sonic tree tomography  
doi:10.3732/apps.1600060 

http://www.bioone.org/loi/apps 3 of 21 

descomposición y daño. La medición exacta de la 
descomposición en un árbol en pie usando el PiCUS 3 
requiere seis pasos: (1) inspección visual y 
documentación fotográfica del tronco, (2) 
posicionamiento estratégico de los sensores sónicos, 3) 
medición de una geometría precisa de la colocación del 
sensor, (4) medición sonora utilizando el PiCUS 3, (5) 
visualización del patrón resultante y (6) cuantificación 
de los patrones de madera comprometidos a partir de 
las imágenes. Los pasos 2 y 3 son especialmente 
críticos y complicados para los árboles con formas 
irregulares, tales como aquellos que son comunes en 
los bosques tropicales. El manual de PiCUS cubre en 
detalle los pasos 2 a 5 para su uso en árboles con formas 
regulares, pero diferimos y ampliamos sus 
recomendaciones sobre cómo manejar los árboles con 
formas irregulares. Debido a que el software de PiCUS 
3 visualiza pero solo proporciona una cruda 
cuantificación de la descomposición, presentamos un 
protocolo estandarizado para el análisis de las 
imágenes producidas por el PiCUS 3 utilizando el 
programa de computadora de fuente abierta, ImageJ 
(National Institutes of Health, Bethesda, Maryland, 
EE.UU.; http://imagej.nih.gov). Aquí presentamos un 
resumen de los protocolos y su aplicación, con pasos 
detallados para la tomografía en el Apéndice 1, análisis 
de imágenes en el Apéndice 2, documentación de 
campo en el Apéndice S1, y sugerencias adicionales 
sobre el uso efectivo del PiCUS 3 para la investigación 
en el Apéndice3. 

1. Inspección visual y documentación fotográfica: La 
inspección visual del tronco es importante para 
identificar anomalías tales como estructuras fúngicas 
reproductivas, evidencia de actividad de insectos, 
daños físicos, cavidades, grietas, vetas, protuberancias, 
contrafuertes y otras irregularidades, así como el 
estado del árbol (aparentemente sano, inclinado, rama 
muerta, etc.), que son útiles para la colocación de los 
sensores y la interpretación de los tomogramas PiCUS 
3. Desarrollamos una hoja de cálculo (Apéndice S1A) 
para recopilar los datos de dicha inspección, así como 
datos importantes relacionados con el proceso de 
tomografía (por ejemplo, circunferencia, número de 
sensores, nombres de especies).  Además, contar con 
fotografías claras del árbol que muestren las etiquetas 
con ubicaciones numeradas de cada sensor en el tronco 
(vea más adelante), es necesario para la subsecuente re-
medición o biopsia invasiva de áreas descompuestas 
(Apéndice S1B). Para la mayoría de los árboles, las 
fotografías de tres posiciones alrededor del árbol (por 
ejemplo, sur, noreste, noroeste) son adecuadas para 
posteriormente hacer coincidir los tomogramas con el 

árbol físico.  
2. Ubicación estratégica de los sensores: El sistema 

PiCUS requiere colocar clavos en el tronco a una altura 
estandarizada y luego conectar los sensores PiCUS a 
cada uno. Estandarizamos nuestro protocolo para 
utilizar 12 sensores para troncos de 20-130 cm de 
diámetro, aunque el programa de computadora del 
PiCUS sugerirá menos o más sensores dependiendo del 
tamaño del tronco. La resolución del tomograma 
aumenta con el número de sensores para un tronco de 
diámetro dado, así que con 12 sensores los árboles 
pequeños tendrán una resolución de detección más fina 
que los árboles grandes. La resolución más fina mejora 
la detección de pequeñas áreas de descomposición 
incipiente que pueden ser ecológicamente más 
importantes en arboles pequeños y ayuda a facilitar la 
determinación del tamaño en el que primero se forma 
la descomposición en los árboles a nivel de población. 
La colocación correcta de los sensores es fundamental 
para garantizar una cuerda geométrica completa a 
través de la madera entre cada par de puntos del sensor: 
es decir, una línea imaginaria para conectar dos puntos 
del sensor no debe pasar fuera del perímetro del árbol 
(Fig. 1A, B, F). El manual PiCUS (p.14) sugiere dos 
alternativas para la ubicación de los sensores en árboles 
con raíces grandes: uno con sensores sobre cada 
distancia mínima y máxima desde el centro del tronco 
y otra que se centra solo en la parte interna del tronco. 
Cuando se aplica a árboles muy irregulares como 
aquellos con contrafuertes, encontramos que la primera 
recomendación genera frecuentemente lecturas 
aberrantes en los contrafuertes y a menudo dentro del 
propio tronco (por ejemplo, Figuras 2A, B); colocando 
los sensores para enfocarse en la parte interna del 
tronco y sacrificando la medición de los contrafuertes 
proporciona escaneos más robustos para cuando son 
necesarias las comparaciones entre diferentes árboles 
(Fig. 2C). Tal estandarización puede ser más 
importante para la investigación ecológica que para la 
evaluación de árboles individuales en la arboricultura. 
Para evitar tales escaneos aberrantes en árboles con 
formas muy desiguales u otras irregularidades (por 
ejemplo, cavidades) en el área de la sección transversal, 
o para medir la descomposición dentro de los propios 
contrafuertes, los sensores deben ser colocados 
cuidadosamente y creativamente para garantizar 
cuerdas geométricas completas entre todos los pares de 
sensores (Fig. 1D, E, F). 

Para posicionar los puntos del sensor, ate el cincho 
entrelazado suministrado alrededor del tronco 
aproximadamente 10 cm por debajo del nivel de 
medición deseado, teniendo cuidado de colocarlo 
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    Fig. 1.   Colocación de sensores del 
Tomógrafo Sónico PiCUS 3 en el 
tronco de árboles de diferentes formas. 
(A) Árbol de forma regular utilizando 
espaciamiento equidistante de sensores 
(Forma en T con números 1 a 12).  
Todas las cuerdas (por ejemplo, 1-4, 4-
8, 8-12, 9-10) incluyendo la cuerda de 
diámetro (1-7) están apropiadamente 
completos (se muestran como líneas 
cortadas) dentro de la línea del tronco. 
(B) Tronco oval con cavidad putrefacta 
(región sombreada) abierta a un lado. 
Todos los sensores son colocados 
alrededor de la línea externa del tronco, 
esquivando la cavidad putrefacta. 
Todas las cuerdas (por ejemplo, 1-2, 1-
4, 1-7, 4-8, 8-12) están completas 
(líneas cortadas) dentro de la línea 
externa del tronco. Las cuerdas 1-2, 1-4 
y 1-7 cruzan la cavidad putrefacta 
interna pero están dentro de la línea 
externa de lo que se presume es un 
tronco intacto. El desplazamiento del 
sonido en esas cuerdas será más largo 
que lo esperado para esa distancia (lo 
cual indica putrefacción) ya que el 
sonido tiene que desplazarse por un 
camino más largo o moverse más 
despacio a través del medio menos 
denso dentro en la cavidad. (C) 

Colocación incorrecta de los sensores en un tronco de árbol con forma irregular. Las cuerdas con líneas 
punteadas están contenidas dentro de la línea externa del tronco pero las cuerdas 2-12, 3-11, 4-12 y 9-10 están 
incompletas (se muestran como líneas punteadas) porque todas ellas pasan por fuera de la línea natural del árbol. 
El tiempo de desplazamiento del sonido será más largo que lo esperado para esas cuerdas y puede producir 
falsos positivos en el tomógrafo, como si pasaran por cavidades putrefactas. En lugar de eso, (D) y (E) muestran 
la colocación correcta de los sensores para un escaneo más efectivo de los mismos troncos con forma irregular 
como en (C) al dividir el tronco en dos regiones de escaneo separadas. (D: sensores 1-12 y E: sensores i-viii) 
para permitir un escaneo por piezas. Dentro de cada sección, todas las cuerdas están completas (líneas 
punteadas) proporcionando medidas robustas de cada parte del tronco. Una pequeña región sombreada entre los 
dos componentes no es escaneada. (F) Sección cruzada de un tronco con contrafuertes. El escaneo excluye 
preferiblemente los contrafuertes y se enfoca en el núcleo interno del tronco colocando cuidadosamente los 
sensores de modo que las cuerdas estén completas (líneas punteadas). Si se requiere, los contrafuertes se 
pudieran escanear separadamente modificando el abordaje mostrado en D y E. Los contrafuertes y otras 
irregularidades a menudo causan que la medición de longitudes específicas de cuerdas sea físicamente difícil 
(por ejemplo, cuerda 2-4 en G y H). Si la cuerda (2-4) se extiende hasta un punto (marcado x) que se accede más 
fácilmente con los calibres electrónicos del PiCUS (G), la longitud de la cuerda 2-4 se puede determinar 
midiendo 2-x y 4-x y luego encontrando la diferencia entre las dos. (H) Alternativamente, los postes se pueden 
extender desde los puntos del sensor a ángulos rectos hasta la cuerda 2-4 y paralelo a cada uno, y luego se mide 
la distancia entre ellas con una regla. Los calibradores rectos de mandíbula larga algunas veces se pueden usar 
para esta medición si la distancia de la cuerda no es demasiado grande.  
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perpendicular al eje principal del tronco. El primer 
clavo (en el cual se cuelga la etiqueta #1 suministrada) 
siempre debe colocarse en el mismo rumbo de la 
brújula (por ejemplo, el punto más meridional) en el 
tronco para facilitar la concordancia del tomograma 
con el árbol físico más adelante. En general, la 
colocación de clavos cerca de la base del árbol (por 
ejemplo, a 10 cm de altura) debe proporcionar la mejor 
evaluación de la pudrición de la base y el daño por 
pudrición del corazón con el PiCUS 3 debido a que los 
hongos asociados tienden a infectar desde la base del 
árbol y desplazarse hacia arriba. En nuestro caso, sin 
embargo, estandarizamos nuestras mediciones a 100 
cm de altura porque también usamos las mediciones de 
la impedancia eléctrica proporcionadas por el PiCUS 
Treetronic (http://www.argus-electronic.de) y la 
proximidad a las raíces afecta los resultados 
proporcionados por este instrumento. Coloque los 11 
clavos restantes y sus etiquetas numeradas en sentido 
contrario a las agujas del reloj alrededor del tronco a 
intervalos de distancia aproximados de la 
circunferencia del árbol dividido entre 12. Las 
distancias son guías aproximadas, y la ubicación tendrá 
que ser ajustada como se ha descrito anteriormente para 
hacer coincidir las irregularidades del tronco. Con los 
12 clavos en su lugar, revise y ajuste la ubicación de 
los clavos para asegurarse de que habrá una cuerda con 
todos los demás puntos (Fig. 1C, D); las cuerdas 
completas, con todos los puntos en un solo plano son 
más importantes que la distancia entre los clavos. 

3. Medición de la geometría de los sensores 
colocados: La medición exacta de la geometría 
transversal de las ubicaciones de los sensores es 
crucial, ya que el PiCUS 3 calcula la velocidad del 
sonido aparente basado en las distancias de las cuerdas 
entre los pares de sensores. Para medir la geometría y 
generar el contorno para la mayoría de los árboles, los 
trabajadores deben utilizar los calibradores PiCUS 
equipados con Bluetooth (Argus Electronic GmbH) 
junto con el software PiCUS. Cuando los calibradores 
no pueden llegar alrededor de una irregularidad del 
contrafuerte o del tronco, el problema generalmente se 
resuelve elevando los calibradores casi paralelos al eje 
del tronco. En casos especialmente difíciles, hemos 
podido obtener buenas mediciones intersensor en una 
de dos formas. Una forma es ampliar visualmente el 
segmento de línea entre los dos sensores que se van a 
medir con el fin de encontrar un punto de medición más 
accesible a lo largo de la misma línea (Figura 1G, 
extensión del segmento de línea 24 a 2x); utilizar los 
calibradores para medir esa distancia, luego medir la 

distancia "extra"(es decir, 4x) con una regla y 
sustraerla de la lectura del calibrador (Fig. 1G). 
Alternativamente, extender los postes paralelos fuera 
del tronco (Fig. 1H), perpendicular a la cuerda y 
delimitado por los dos clavos inaccesibles, y luego 
medir la distancia entre ellos con una regla. 

4. Medición sonora utilizando el PiCUS 3 y  
5. Visualización del patrón resultante: Siga las 

instrucciones claramente proporcionadas en el manual 
de PiCUS. El martillo equipado con acelerómetro se 
utiliza para golpear ligeramente en secuencia cada uno 
de los clavos varias veces, de modo que el tiempo de 
tránsito del sonido se pueda medir a lo largo de cada 
cuerda posible (132 cuerdas para 12 sensores). Para 
visualizar los patrones de descomposición usando el 
software PiCUS, encontramos que las configuraciones 
predeterminadas funcionaron bien, excepto que 
siempre usamos el filtro de corrección en rueda dentada 
(“cogwheel”) para eliminar la falsa indicación de 
descomposición cerca del perímetro entre los sensores. 
Esto no afecta la visualización precisa en ausencia del 
artefacto en rueda dentada y reduce en gran medida los 
falsos positivos de un problema conocido, tal como se 
describe en el manual PiCUS. 

6. Cuantificación de patrones de madera 
comprometida: La cuantificación de áreas de madera 
sanas y aparentemente descompuestas requiere la 
exportación de dos imágenes PiCUS del software 
PiCUS: (i) la imagen geométrica sin el escaneo (esta 
puede realizarse antes del paso 4 o recargando el 
archivo de geometría en el software PiCUS), y (ii) el 
escaneo visualizado. Para el escaneo visualizado, 
utilice el filtro de corrección en rueda dentada y 
desactive la función "detector de grietas" (“crack 
detector”) antes de la exportación. Ambas imágenes 
son necesarias porque el escaneo visualizado 
superpone el contorno del árbol, los números de 
sensores y las marcas comerciales del PiCUS a partir 
de la imagen geométrica en la imagen del escaneo 
visualizado, utilizando colores azules y rojos que 
también se usan para indicar la descomposición en las 
imágenes visualizadas. Tratando separadamente las 
dos imágenes, las áreas de madera sana y 
descompuesta medidas en la imagen de escaneo 
visualizado pueden corregirse ajustando las áreas 
medidas en la imagen geométrica. Usamos el software 
de análisis de imágenes gratuito ImageJ (National 
Institutes of Health; http://imagej.nih.gov) para 
calcular la proporción del área transversal total del 
tronco que tiene madera sana (marrón y negro), un 
poco de descomposición (verde) y descomposición 
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Fig. 2. Imágenes 
ilustrando elementos claves 
para la colocación apropiada 
de los sensores para el estudio 
de tomografía sonora fiable 
de putrefacción interna de 
cuatro individuos vivos de 
árboles de Alseis blackiana en 
Barro Colorado, Panamá. (A) 
Alseis blackiana (etiqueta de 
parcela 2379) con tronco de 
forma irregular debido a 
contrafuertes.  
(B) Tomograma de árbol 
2379 con sensores colocados 
inapropiadamente en los 
puntos extremos de afuera y 
de adentro de los 
contrafuertes (los números 
rojos indican la posición de 

los sensores). Nótese las puntas anormales de los contrafuertes de color verde y magenta cerca de los sensores 3 y 
7; la madera muestreada usando broca de un cuarto de pulgada del área que indica putrefacción no mostró signos 
de decoloración o descomposición en 0-5cm o en 5-10cm de profundidad, lo cual indica un falso positivo. En su 
lugar, esta era madera estructuralmente intacta dentro de los contrafuertes. Posición de la recolección marcada con 
una bolsa de recolección sobre el tronco en A. (C) Colocación apropiada del sensor en el árbol 2379 (ubicado 
como se sugiere en la Fig. 1F) excluye los contrafuertes del tomograma. La línea externa de la geometría escaneada 
superpuesta es visible como el área gris en B. (D) Tomograma de A. blackiana 4528, mostrando una gran área de 
descomposición. La madera muestreada mostró evidente decoloración y descomposición a los 5-10 cm, mas no 
así as los 0-5 cm, como sugería el tomograma. (E) Tomograma de A. blackiana 4014 mostrando áreas distribuidas 
de descomposición menor. La madera muestreada mostró evidente decoloración y descomposición en áreas 
sospechadas pero madera aparentemente saludable a los 5-10 cm de profundidad, en concordancia con el 
tomograma. (F) Tomograma A. blackiana 7195 aparentemente saludable. Las muestras de madera entre los 
sensores 6 y 7 estaban aparentemente saludables a los 0-10 cm de profundidad. 

 
 

severa o cavidad (azul, magenta y blanco). Estas 
mediciones se ajustan entonces para eliminar las áreas 
de este análisis que son etiquetas del archivo de 
geometría. El Argus Electronic advierte sobre las 
diferencias de interpretación de los colores para reflejar 
la gravedad de la descomposición, por lo que el 
enfoque conservador es combinar juntos todos los 
tonos que no son de madera sana como indicación de 
madera comprometida. Los detalles del protocolo de 
análisis de imágenes se muestran en el Apéndice 2. 

Pruebas de campo – Desarrollamos y refinamos 
estos protocolos mientras usamos el PiCUS 3 para 
crear tomogramas de >1800 individuos y 173 especies 
de árboles en la investigación sobre descomposición 
interna de troncos (Gilbert et al., Datos no publicados). 
Nuestro trabajo se enfocó en el bosque húmedo 

tropical, semideciduo, estacional de tierras bajas en el 
Parque Nacional Soberanía (9.13688° N, 79.72413° O, 
75 m.a.s.l.; Parcela 2 como se describió en Gilbert y 
Webb, 2007) y en la parcela dinámica forestal de 50 
hectáreas de la Isla de Barro Colorado (9.151267833° 
N, 79.85529978° W, 120 m.a.s.l., Hubbell et al., 1999), 
en la cuenca del Canal de Panamá, República de 
Panamá. (En el Apéndice 4 se incluye información de 
comprobantes para las especies presentadas en este 
documento). Aquí presentamos un subgrupo de 
imágenes escaneadas para ilustrar el protocolo. Los 
árboles con tronco de forma regular (redonda a 
ovalada) son fácilmente escaneados siguiendo los 
protocolos descritos en el manual del usuario de PiCUS 
3 y el video de flujo de trabajo y la presentación en su 
sitio web (http://www.argus-electronic.de/en/tree-
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inspection-technology) (Fig. 1A, B, Fig. 2D, E, F). 
Debido a que la mayoría de los árboles en el bosque 
tropical húmedo tienen corteza más delgada, el uso de 
clavos de tapicería de níquel aplanados en lugar de 
clavos para techos fue eficaz y redujo incluso el daño 
mínimo causado por los clavos más grandes a través de 
la corteza y en la madera exterior, aunque las especies 
con corteza más gruesa requirieron el uso de clavos 
más grandes (Apéndice 3). La descomposición fue 
generalmente más extensa cerca de la base del árbol y 
disminuyó a mayor altura como era de esperarse para 
patógenos de pudrición de contrafuertes y del centro 
del tronco que entran a través del sistema de raíces y 
colonizan hacia arriba a través del xilema del duramen 
(Apéndice3). En algunos casos, sin embargo, la 
infección estaba aparentemente asociada con ramas 
rotas o puntos de rama y la descomposición fue mayor 
cerca del punto de infección. 

Destacamos que el protocolo para colocar sensores 
en los árboles con formas irregulares fue eficaz para 
mejorar la calidad de los escaneos y reducir las 
aberraciones que aparecieron con la descomposición. 
La colocación de sensores para asegurar que todos los 
pares de sensores tenían cuerdas completas dentro del 
perímetro del árbol, junto con una cuidadosa medición 
de la geometría del sensor, aseguró que todos los 
árboles, excepto los más complejos, pudieran ser 
escaneados exitosamente (Fig. 2). La estructura del 
tronco era demasiado compleja para escanear algunas 
especies (por ejemplo, higos estranguladores como 
Ficus obtusifolia). 
 
 

CONCLUSIONES 
La tomografía sónica usando el tomógrafo sónico de 

Argus Electronic PiCUS 3 puede detectar y medir 
patrones de descomposición interna de árboles vivos 
sin dañar los árboles. Nuestro protocolo proporciona 
un abordaje eficaz y estandarizado para utilizar el 
PiCUS 3 bajo condiciones difíciles y especialmente 
para especies de árboles tropicales con troncos con 
contornos altamente irregulares que pueden causar 
tomogramas errados. 

La adición de un protocolo estandarizado de 
procesamiento de imágenes para cuantificar la 
proporción de área del tronco que muestra 
descomposición, amplía el uso del PiCUS 3 más allá 
de las aplicaciones más comunes en la arboricultura y 
la evaluación de los peligros para las actividades de 
investigación ecológica y forestal. 

 Si bien la eficacia de la tomografía para detectar la 
descomposición de la madera ha sido bien establecida 

para su uso en árboles de forma regular, el uso 
extendido de esta tecnología para una diversidad de 
especies de árboles tropicales con troncos altamente 
irregulares, contrafuertes, raíces de anclaje, y 
diferentes patrones de producción de madera se 
beneficiarían de los continuos esfuerzos de validación. 
Esto se puede hacer aprovechando oportunidades de 
escanear los árboles que se van a talar, y dándole 
seguimiento a la inspección post-corte de los patrones 
de descomposición de la madera dentro del tronco 
(Gilbert y Smiley, 2004). Adicionalmente, la 
extracción mínimamente invasiva de muestras de 
madera o material de madera, como hemos hecho aquí, 
se puede utilizar para evaluar rápidamente los patrones 
de integridad y descomposición de la madera asociados 
con los patrones mostrados en los tomogramas PiCUS 
3. Considerando que los métodos estandarizados para 
tomografía son utilizados en una gran diversidad de 
especies de árboles, bajo diferentes condiciones de 
crecimiento, la utilidad de la tomografía como una 
herramienta de investigación seguirá creciendo. 
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Apéndice 1. Protocolo para Tomógrafo Sónico básico PiCUS 3. 
Antes de ejecutar el protocolo a continuación, todos los clavos deben esterilizarse con autoclave y el Tomógrafo 
Sónico PiCUS 3 (Argus Electronic GmbH, Rostock, Alemania), los calibradores, la cámara y la computadora 
deben estar totalmente cargados. Nota: Las instrucciones aquí son para tomogramas de una altura de 100 cm; se 
pueden utilizar otras alturas pero para la comparación entre árboles es importante una altura estandarizada.  

1. Conduzca una cuidadosa inspección visual del árbol, anotando su ubicación; fecha; especie; personas 
que conducirán el escaneo; el estado de salud del árbol; signos y síntomas de pestes, patógenos u otros 
similares; irregularidades del tronco; daño físico aparente; etc. Asocie dónde se ubican estas 
observaciones en el tronco con respecto a las ubicaciones de los sensores cuando se establezcan en los 
pasos 5-8. Ver apéndice S1 para detalles y ejemplos.  

2. Establezca las ubicaciones de los sensores. Conecte el cinturón entrelazado azul apretadamente 
alrededor del árbol a una altura de 80 cm sobre el nivel del suelo. El cinturón sirve de guía para 
geometría y como un gancho para el PiCUS 3. 

3. Mida la circunferencia del árbol envolviendo una cinta métrica a una altura de 100 cm, midiendo desde 
el punto más alto que alcanza la tierra en el tronco y perpendicular al eje central del tronco.  

4. Mida el perímetro del contorno del árbol presionando la cinta métrica de modo que siga las curvas del 
tronco a la misma altura. No siga el perímetro a través de las cavidades en descomposición; sino que 
calcule dónde hubiera estado el tronco intacto. El perímetro: la ratio de la circunferencia proporciona una 
medida aproximada de la irregularidad de la forma del tronco.  

5. Coloque el primer clavo a 100 cm de altura en el punto ubicado más hacia el sur del árbol 
colocando la brújula al lado del tronco para encontrar dónde la flecha que indica norte señala el centro 
del tronco. Los clavos deben entrar justo lo suficiente como para hacer contacto sólido con la madera sin 
que pueda caerse. Cuelgue la etiqueta de #1 sobre el clavo. 

6. Determine el espacio entre los clavos dividiendo la circunferencia del árbol entre 12 (número de 
sensores). 

7. Coloque los 11 clavos restantes en línea recta (perpendicular al eje central del tronco) alrededor del 
tronco con el espacio determinado en el paso 6. Evite contrafuertes o irregularidades significativas y no 
ponga clavos dentro de la madera obviamente descompuesta. Las distancias entre los clavos son guías 
aproximadas y pueden requerir ajustes tal como se describe en el paso 8 a continuación. Cuelgue el resto 
de las etiquetas numeradas en los clavos en dirección opuesta a las manecillas del reloj (vistas desde 
arriba). 

8. Revise las posiciones de todos los clavos, visualizando una trayectoria directa desde cada clavo hacia el 
resto de los clavos (las cuerdas de la sección cruzada). Todas las cuerdas deben pasar a través del interior 
del perímetro del tronco; si no lo hacen, ajuste las ubicaciones de los clavos, manteniéndose siempre en 
el mismo plano para que las cuerdas pasen a través del perímetro del tronco intacto. Nota: Si hay alguna 
cavidad descompuesta, la cuerda puede pasar a través del espacio abierto pero esta cuerda no debe pasar 
a través del espacio abierto entre los contrafuertes. Ver Fig. 1. 

9. Registre el número de clavos que mejor represente el diámetro (usualmente clavos #1 y #7), notando 
cuál clavo está más hacia el sur (usualmente el clavo #1). Estos representan los “puntos de referencia con 
respecto al eje”. 

10. Tome tres o más fotos del tronco del árbol mostrando las posiciones de todos los clavos (usualmente 
desde aproximadamente el sur, noreste y noroeste). Tome fotos adicionales de cualquier irregularidad o 
señal notoria de plagas o patógenos, siempre que sea posible, incluyendo los números de las etiquetas de 
PiCUS en la foto. Registre los números de imágenes en la página de datos. Vea el apéndice S1.  

11. Prepárese para medidas geométricas.  
a. Encienda la computadora y abra el programa PiCUS 3. Seleccione la opción Sonic Tomogram. 

Select Measurement > Tree Geometry > Free Shapes Cliper. Cambie los puntos de medida de registro 
a 12, introduzca la circunferencia del árbol en milímetros y use 1 y 7 como ejes predeterminados. 
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Guarde el archivo usando alguna convención descriptiva (por ejemplo, CodigoDeEspecies.Etiqueta#; 
QUARAS.4356). Esto crea un archivo de tipo y nombre de extensión .PiT.  

b. Saque los calibradores y desdóblelos. Calibre presionando ambos botones para encenderlo, ponga 
las puntas juntas para cero, luego coloque las puntas del calibrador a exactamente 1m de distancia 
(puede cortar una pieza de tubo PVC de 1m de largo para mantener en el estuche del calibrador), 
presionando los botones conforme a los mensajes mostrados en la pantalla. Fije los calibradores en 
modo de Bluetooth presionando el botón de la izquierda dos veces y establezca conexión con la 
computadora seleccionando el botón Com en el programa PiCUS. 

12. Mida la geometría utilizando los calibradores. Siga las sugerencias en la pantalla de los calibradores 
para medir la distancia entre puntos específicos en secuencia, asegurándose de presionar los botones L 
(izquierdo) o R (derecho) cuando así se indique (* significa cualquier botón). Esto se hace más 
fácilmente si una persona sostiene los puntos de los calibradores en la base del clavo en el punto de 
pivote, en tanto que otra persona alinea el otro brazo en la base del segundo clavo y presiona el botón del 
calibrador para tomar las medidas. Asegúrese de que los datos estén siendo transmitidos a la 
computadora. Cuando haya terminado, presione el botón de Calcular en la computadora y luego OK 
(aceptar) para guardar el archivo de geometría (se guardará con el nombre EspecieCódigo.Etiqueta#.PiT 
dado en el paso 11a). 

13. Confirme que el contorno del árbol coincida con la forma del árbol. Las líneas cruzadas 
generalmente indican que el botón izquierdo fue presionando erróneamente, en lugar del botón derecho. 
Estos se pueden editar en la hoja de geometría del programa PiCUS y recalcularse, o puede volver a 
medir pares de puntos en particular e introducir a mano la distancia mostrada por la pantalla del 
calibrador. Cuando esté satisfecho con la geometría, guarde el archivo y guarde los calibradores.  

14. Exporte la imagen de geometría como un archivo JPEG (usualmente pesan alrededor de 50 KB) para 
su análisis posterior usando File > Save Picture as, utilizando la convención para el nombre de imagen 
mostrada anteriormente: EspecieCódigo.Etiqueta#.Geometría.jpg. 

15. Cree el tomograma sónico. Cuelgue el PiCUS 3 del cinturón azul debajo del clavo #7 (Fig. A1-1). 
Cuidadosamente ate los cables del sensor al PiCUS 3 (Junte los puntos rojos de modo que no se 
contoneen) y luego ate los imanes del sensor a los clavos correspondientes, asegurándose de que los 
números en los sensores y las etiquetas coincidan. Asegúrese de que todos los sensores estén bien 
puestos en sus respectivos clavos y correctamente colocados.   

16. Cargue el archivo de geometría en el programa de PiCUS de la computadora; seleccione File > Load, 
seleccione el archivo .PiT que usted creo para la geometría y luego seleccione Open File.  

17. Encienda el Tomógrafo Sónico PiCUS 3 y conéctelo a la computadora.  
18. Conecte el martillo a través de Bluetooth presionando cualquier botón del martillo y luego haciendo clic 

en el botón Com en el programa PiCUS. 
19. Reemplace el sensor magnético #1 con el pin de golpear que está fijado al martillo (el lado ancho es 

magnético y está atado al clavo; el lado angosto es para golpear con el martillo). Presione los botones de 
up (arriba) o down (abajo) en el martillo hasta que lea #1 y luego la computadora dice “Uno.” 

20. Usando el martillo, golpee ligeramente y directamente en el pin de golpear en tanto que usa su mano 
libre para estabilizarlo sosteniendo el cable cerca del pin. Golpee repetidamente (usualmente 3 a 4 veces) 
cada vez que la computadora lo solicite, hasta que diga “Las medidas en este punto han sido guardadas”. 
Adicionalmente los golpecillos en cada punto proporcionan medidas más precisas del tiempo de 
recorrido del sonido, pero sacrificando tiempo de muestreo adicional.  

21. Mueva el pin de golpear al clavo #2 y reemplace el imán del sensor en el clavo #1. Presione el botón de 
up en el martillo para cambiar el número a #2 y espere hasta que la computadora diga “Dos”. Presiones 3 
a 4 veces. Repita este paso con cada clavo sucesivo hasta completar todos los sensores.  

22. Guarde el archivo cuando los 12 clavos hayan sido golpeados, haga clic en OK (guarda el archivo 
como .PiT). 
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23.!Calcule el tomograma haciendo clic en el ícono que se asemeja a un scan. Asegúrese de que el filtro en 
rueda dentada esté encendido y que el detector de grietas este apagado. Haga clic en el ícono Guardar el 
archivo escaneado. Exporte el archivo como JPEG para su análisis posterior usando File > Save image 
as, seguido de la convención de uso de nombre de archivo EspecieCódigo.Etiqueta#.PiT.jpg. 

24.!Guarde la interpretación y observaciones en la hoja de datos (por ejemplo, “el escaneo muestra 
descomposición alrededor del #7; la inspección del tronco indica un área oscura hundida justo arriba del 
#7”). 

25.!Asegúrese de que toda la información se guarde en la hoja de datos. Vea el Apéndice S1. 
26.!Termine. Apague el PiCUS 3 y retire el martillo, sensores, cables y clavos. Si desee, deje el clavo #1 en 

su lugar para poder reubicarlo con precisión en el futuro.  

 
 
 
  

 
Fig. A1-1.  El Tomógrafo Sónico PiCUS 3 
y sus cables instalados en un árbol. 
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Apéndice 2. Protocolo de análisis de imágenes para cuantificar la descomposición con los tomogramas PiCUS 3. 
 
El análisis de los archivos tomográficos como se describe a continuación se realiza utilizando el software 
gratuito ImageJ versión 1.51f (National Institutes of Health, Bethesda, Maryland, EUA; http://imagej.nih.gov). 
El análisis requiere dos imágenes JPEG exportadas desde el archivo de tomografía .PiT (~ 50 KB cada una): (a) 
la imagen de la geometría (SpeciesCode.tag # .geom.jpg; Apéndice 1, paso 14) y (b) la imagen del tomograma 
(SpeciesCode.tag#.jpg, Apéndice 1, paso 23). 
 

1. Abra la aplicación ImageJ en su computadora. Seleccione File > Open y elija el nombre de su imagen de 
tomografía. 

2. Registre la escala de la imagen (Fig. A2-1). Haga clic en el botón de la herramienta "Freehand Line" y 
dibuje una línea a lo largo del eje Y de la imagen desde la intersección (0,0) hasta la marca más alta en el 
eje Y.  

3. Seleccione Analyze > Set Scale. Esto abre una nueva ventana, donde debe hacer clic en “Known Distance” 
("Distancia conocida") y reemplazar esta con el valor más alto en el eje Y. 

4. Marque la casilla Global y haga clic en OK. 

5. En la barra de menú, seleccione Image > Ajust > Color Threshold. Haga clic en el menú Color Space y 
seleccione HSB. 

6. Ajuste las barras de desplazamiento en la ventana Threshold Color para los paneles de tono, saturación y 
brillo de manera que toda la imagen y letras sean seleccionadas y se vuelvan rojas; haga esto, ajustando 
cada uno de los deslizadores inferiores al valor máximo de 255. Ajuste los valores de los controles 
deslizantes superiores para Hue (Matiz) y Brightness (Brillo) al valor mínimo de 0 y el valor de saturación 
de la barra superior a 40. Haga clic en “Select”. 

7. En la barra de menú, seleccione Analyze > Measure. Esto debe crear una nueva ventana de resultados con 
el valor del área total (en color) (en cm2) de la imagen. 

8. Mida el área de descomposición total (Fig. A2-1). En la ventana Threshold Color, con la misma 
configuración anterior, cambie solo la barra superior de Hue a 40 y haga clic en “Select”. 

9. Seleccione Analyze > Measure. Esto debea añadir un nuevo valor a la ventana de resultados con el valor 
del área total descompuesta (en cm2). Esto incluye todos los colores que no son tonos de chocolate o 
negro. Nota: Este número debe ser menor que el valor total del área. Si no lo es, entonces algo está mal. 

10. Mida el área severamente descompuesta (Fig. A2-2). En la ventana Threshold Color, establezca la barra 
superior de Hue en 110. Haga clic en Select. 

11. Seleccione Analyze > Measure. Esto debe agregar un nuevo valor a la ventana Resultados con el valor del 
área severamente descompuesta (en cm2) (áreas de magenta, rojo, azul y blanco). 

12. Mida el área aportada por la imagen geométrica (Fig. A2-2). En la barra de menú, seleccione File > 
Open y seleccione su archivo de imagen de geometría. Repita los pasos 2-7. El valor resultante 
corresponde al área aportada por las etiquetas 1-12, el contorno azul del árbol y el logotipo en la parte 
inferior derecha a las áreas de la misma medida en el tomograma. 

13. En la ventana Resultados, seleccione “Save as” para guardar datos como una hoja de cálculo de Excel. 
Utilice una convención de nomenclatura similar a SpeciesCode.Tag#.Area.xls. Etiquete las medidas como 
ÁreaTotal, Descomposición, DescomposiciónSevera, Geometria, según corresponda. 

14. Reste el valor de Geometría de cada una de las otras tres medidas antes de analizar los datos. 
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Fig. A2-1. Captura de pantalla para ilustrar el protocolo para usar ImageJ para cuantificar la descomposición (pasos 2 a 9).

Pasos 2-3. Con su imagen de tomografía jpg 
abierta en ImageJ, use la herramienta 
“FreeHand line” para dibujar una línea desde 
el punto 0 hasta la marca superior (aquí 58) 
en el eje vertical. Haga clic on             , luego 
posicione la mira sobre el punto 0,0. Haga 
clic y mantenga, arrastrando hacia arriba 
hasta que la mira cubra la marca a 58, luego 
libere. Esto crea una línea amarilla. Luego 
seleccione Analyze > Set Scale (ajustar 
escala) en el menú. 

el punto 0 hasta la marca superior (aquí 58) 
en el eje vertical. Haga clic on             , luego 

Paso 4. En la ventana de ajustar escala, 
reemplace la distancia conocida con el largo 
de la línea que acaba de dibujar en cm. En 
este caso es 58 (el valor de la marca superi-
or). Marque la casilla Global para que la 
configuración de escala en píxeles / cm se 
aplique en las direcciones X y Y.

Paso 5 y 6. Seleccione Image > Adjust 
> Color Threshold desde el menú para 
abrir la ventana de Threshold Color. 
Establezca el espacio de color en HSB. 
Arrastre el control deslizante para 
establecer los valores de Hue: 0, 255; 
Saturation: 40,255; Brightness: 0, 255.  
Haga clic en "Select" y el rojo cambia a 
un contorno amarillo.

Paso 7. En el menú, seleccione Analyze > Measure 
para crear una nueva ventana de Resultados con el 
valor del área total (color rojo umbral) de su 
tomógrafo (en cm cuadrado), incluyendo todas las 
etiquetas.

Pasos 8 y 9. Para seleccionar solo el área del tomograma con 
colores de descomposición (así como las etiquetas de color 
similar), establezca los valores de Hue en 40, 255.  Al igual que en 
los pasos 6-7, haga clic en "Select", luego Analyze > Measure en el 
menú. Esto agregará área de las porciones rojas arriba a una 
nueva línea en la ventana de resultados.
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Fig. A2-2. Captura de pantalla para ilustrar el 
protocolo para usar ImageJ para cuantificar
la descomposición (pasos 10-14).

Pasos 10 - 11. Siguiendo una trayectoria similar se 
obtiene una medida de los componentes "severa-
mente descompuestos" en magenta y azul (de nuevo, 
incluyendo la línea azul y las etiquetas rojas). En el 
panel Threshold Color seleccione Hue a 110, 225, haga 
clic en "Select" y luego en  Analyze > Measure en el 
menú. Esto agrega una tercera línea a la ventana de 
Resultados, que es el área que se acaba de medir.

Paso 12. Para encontrar el área representada por la línea de 
traza y las etiquetas en el tomograma, abra el archivo 
xxx.geom.jpg en ImageJ. Repita los pasos 2-6 para calibrar la 
escala en la imagen, ajuste la configuración de threshold color 
settings a Hue: 0,255, Saturation: 40, 255, and Brightness: 0, 255, 
haga clic en  “select” y luego Analyze > Measure en el menú. 
Esta cuarta línea en la ventana de Resultados es entonces el 
área "extra" de la línea de tomografía y las etiquetas.

Paso 13-14. Con la ventana de Resultados activa, seleccione File > Save 
As en el menú y proporcione un nombre razonable para exportar las 
mediciones al archivo compatible con Microsoft Excel. Abra el archivo 
en Excel u hoja de cálculo similar. Proporcione etiquetas apropiadas 
para cada una de las mediciones (como en la celda A2: A5). Reste el 
área del archivo xxx.geometry.jpg (celda B5) de cada una de las otras 
áreas para corregir el área medida para el área ocupada por líneas y 
etiquetas (celdas F2: F5), AdjArea). Finalmente, el porcentaje de área 
indicada como descompuesta es F3 / F2 * 100 y la descomposición 
severa F4 / F2 * 100 (PercentDecay). 
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Apéndice 3. Consejos para el uso eficaz del Tomógrafo Sónico PiCUS 3 en la investigación ecológica. 
 

1.!Debido a que la descomposición interna a menudo procede de la base del árbol hacia arriba (pudrición de 
raíz > pudrición de la base > pudrición del corazón), las mediciones deben hacerse lo más cerca posible de la 
base del árbol. Sin embargo, para utilizar el PiCUS 3 en combinación con PiCUS TreeTronic (análisis de 
impedancia eléctrica del contenido de agua del tronco, Argus Electronic GmbH), la altura mínima sobre el 
suelo debe ser al menos tan alta como el diámetro del árbol, ya que el PiCUS TreeTronic no puede utilizarse 
si los sensores se colocan a una distancia que está más cerca de las raíces o puntos de rama que la medida del 
diámetro del árbol. Por ejemplo, para un árbol con un diámetro de 85 cm, los sensores del PiCUS TreeTronic 
deben colocarse a un mínimo de 85 cm por encima del nivel del suelo. Hemos normalizado nuestras 
mediciones a 100 cm para las comparaciones entre especies y realizamos escaneos adicionales a 10, 50, 150 
y 200 cm para examinar la estructura de las columnas de descomposición en algunos árboles. En la mayoría 
de los casos, la descomposición es mayor en la base y disminuye hacia arriba, lo que refleja un patrón común 
de progresión de la enfermedad (Fig. A3-1). 
 
 

2.! Los clavos deben ser magnéticos (es decir, acero o níquel, pero no aluminio) y tener una cabeza ancha y 
plana (Fig. A3-2). Para árboles de corteza delgada, usamos clavos de tapicería de níquel (National Hardware 
V7730 N279-174) y aplanamos las cabezas con un mazo. Para árboles con cortezas más gruesas, utilizamos 
clavos de acero cortos (pero con cabezas grandes) que penetran en la madera. Es mejor tener un número de 
clavos de diferentes tamaños disponibles y utilizar el clavo más pequeño para minimizar el daño a los 
árboles; cada clavo solo necesita pasar a través de la corteza para hacer contacto sólido con la madera. 

3.! Los clavos deben esterilizarse antes de cada uso (por ejemplo, esterilizados en autoclave durante 15 minutos 
a 121°C o remojados durante 30 minutos en cloro diluido [10% en volumen] y luego enjuagados 
exhaustivamente) para evitar cualquier transferencia de microorganismos entre árboles. 

4.! Los troncos deben tener generalmente más de 20 cm de diámetro para un escaneado eficaz, aunque hemos 
escaneado con éxito árboles de tan solo 15 cm. Para troncos muy pequeños, a veces utilizamos menos de 12 
sensores, siguiendo las recomendaciones del manual del usuario del software PiCUS. 

5.! Para troncos más grandes o troncos muy irregulares, usamos a veces 24 puntos de sensor (consulte el manual 
del usuario de PiCUS para saber cómo desplegar más de 12 sensores). 

6. Con árboles muy grandes, la conexión Bluetooth entre el Tomógrafo Sónico PiCUS 3, la computadora y el
martillo puede no funcionar bien. En este caso, utilice el cable para conectar el martillo directamente al 
tomógrafo PiCUS. 

  

 
Fig. A3-1. En la mayoría de los casos, las columnas de descomposición son las más grandes 
cerca de la base del árbol y disminuyen con la altura, como para esta Casearia arborea 
(etiqueta 2709) escaneada a 10, 100 y 150 cm sobre el nivel del suelo. 
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7.! Algunas especies de árboles con tejido interno esponjoso para el almacenamiento de agua, y todas las 
palmas, producen tomogramas poco fiables que son difíciles de interpretar. El escaneo directo de 
contrafuertes puede parecer hueco no por la descomposición, sino por una estructura hueca o tejido interno 
blando. Utilice el conocimiento sobre la estructura de los árboles (literatura, operaciones madereras o 
encontrar individuos muertos para el estudio) para evaluar posibles problemas con especies individuales si 
hay razón para cuestionar los resultados. 

8.! Los tomogramas que indican descomposición cerca de formas irregulares y contrafuertes requieren una 
inspección cuidadosa de la configuración para asegurarse de que la colocación de sensores es apropiada. 

9.! Una mochila de marco (por ejemplo, OutdoorZ 3699998 Commander Freighter Frame; ALPS 
Mountaineering, New Haven, Missouri, EE.UU.) funciona bien para transportar equipo pesado 
a través de terreno accidentado. Empaque lonas impermeables para una rápida protección del equipo. 

10.!La duración de la batería de la computadora es generalmente más corta que la duración de la batería usada 
para el Tomógrafo Sónico y los calibradores PiCUS 3. Para largos días de campo, lleve consigo las baterías 
de repuesto de la computadora. 

11.!También útil: taburete plegable para computadora, regla métrica plegable, cinta diamétrica para ingenieros 
forestales, recipiente para colocar los clavos usados, brújula, hojas de datos pre-impresas, cámara digital 
resistente al agua. 

 
 
Fig. A3-2. Ejemplos de clavos de tapicería de níquel (superior, con 
cabeza intacta [a la derecha] o aplanada para un mejor contacto con 
el sensor [izquierda]) para especies de árboles de corteza delgada y 
clavos de techos de acero más grandes (medio y más abajo) 
utilizados para especies de árboles de corteza gruesa.!
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Apéndice 4. Comprobantes para las especies escaneadas presentadas en este estudio. Los comprobantes indicados 
son para individuos separados de la misma especie recolectados en la Isla Barro Colorado y depositados en el 
Herbario de la Universidad de Panamá. 
 

 
Species  

Voucher specimen 

accession numbera  
Collection 

localityb   
Number of 
individuals  

Alseis blackiana 80269 BCI 1 
Casearia arborea  73418 BCI 2  
Trichilia tuberculata  80299 BCI  1 

 
a Los comprobantes de estas especies (no necesariamente los individuos presentados) han sido depositados en el 
Herbario de la Universidad de Panamá (PMA) en nombre del Centro de Ciencias Forestales del Trópico, Instituto 
Smithsonian de Investigaciones Tropicales. Se han dado los números de acceso de código de barras.  

bSitio de estudio: BCI (parcela de 50 hectáreas en la Isla de Barro Colorado, Panamá 
[9.151267833° N, 79.85529978° W, 120 m a.s.l.]). 
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Materiales suplementos. Documentación para el uso efectivo del Tomógrafo Sónico PiCUS 3 

 
               Hoja de datos para apuntar datos visuales y de tomografía en el campo.    

Fecha: Especie:

Ubicación: Arbol	#:

Personas:	

Medidas Numero	de	sensores
Diámetro	(DBH)	(mm): #	para	geometría:

Circunferencia	(mm): #	para	PiCUS:

Perimetro	(mm): Circumf/#puntos:

#	del	clavo	lado	sur:

clavos	en	eje	principal:

Fotos	de	documentación

Observaciones Estatus	del		árbol:

S=saludable; H=tronco hueco; Y=tronco 
caido con raices afuera; Q=tronco roto; 
DC=muerto caido; DS=muerto de pie

Asociados:
N=ninguno; F=hongos; H=hormigas; 
C=comejenes; L=lianas/epífitos

¿Síntomas	de	enfermedad	(si/no)?
Observaciones:

¿Tomografía	indica	pudrición	(si/no)?
Observaciones:

Muestra	de	madera	(si/no)?
Observaciones:

¿Hongo	colectado	(si/no)?
Observaciones:
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Tres imágenes del árbol Trichilia tuberculata, etiqueta 3792, desde los lados sur, nordeste y noroeste 
del tronco, mostrando la ubicación de los clavos para la tomografía (etiquetas negras con números) en 
relación con los rasgos del tronco.  
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Ejemplos de las categorías de estatus de los troncos. S = Aparentemente sano.  H = Tronco hueco de un 
árbol vivo.  Y = Árbol caído con sus raíces afuera, pero vivo (i.e., con hojas verdes).  Q = Árbol roto, 
pero vivo (aquí, con retoño del tronco).  DC = Árbol muerto y caído.  DS = Árbol muerto de pie. 
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Ejemplos de los organismos asociados a los árboles y síntomas de enfermedades. A. Una basidiomata (estructura 
reproductiva) de un hongo (código de asociado F).  B. Un cancro en el tronco de un árbol (síntoma).  C. 
Exudados asociados con una lesión en el tronco (síntoma).  D. El tronco enredado por una liana (código de 
asociado L).  E. Epífita sobre el tronco (código de asociado L).  F. Sendero de comejenes (código de asociado C) 
en medio de una manta de musgo y hepáticas epífitas (código de asociados L).  G. Nido de hormigas Azteca 
(código de asociado H).  H. Pudrición de raíces expuestas en un árbol con código del estatus Y (síntoma).  I. 
Herida en el tronco (síntoma), y hueco por dentro (código del estatus H).   




